
MapInfo Professional 12.0.2
Release Notes

This document provides information on new and enhanced features that have been introduced
into MapInfo Professional since version 12.0. It also contains sections on resolved customer
issues and some remaining known issues that are important for users to be aware of.

You can apply this update to MapInfo Professional 12.0.
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Before You Continue
This release upgrades 12.0 and 12.0.1 installations of MapInfo Professional to version
12.0.2. Follow the instructions provided in this document under Upgrading MapInfo
Professional.

Upgrading MapInfo Professional
Your computer must be connected to the Internet to download the 12.0.2 Maintenance
Release.

You may install this Maintenance Release provided one of the following products is
already installed:

• MapInfo Professional 12.0 or 12.0.1
• MapInfo Professional Runtime 12.0 or 12.0.1

Asia Pacific/Australia:
Phone: +61 2 9437 6255
pbsoftware.australia@pb.com
pbsoftware.singapore@pb.com
www.pitneybowes.com.au/software

Canada:
Phone: 1 800 268 3282
pbsoftware.canada.sales@pb.com
www.pb.com/software

Europe/United Kingdom:
Phone: +44 (0) 1491 416 600
pbsoftware.emea@pb.com
www.pitneybowes.co.uk/software

India:
Phone: +91 120 402 6000
contactindia@pb.com
www.pitneybowes.co.in/software

United States:
Phone: 1 800 327 8627
pbsoftware.sales@pb.com
www.pb.com/software

© 2013 Pitney Bowes Software Inc. All
rights reserved. Pitney Bowes Software
Inc. is a wholly-owned subsidiary of Pitney
Bowes Inc. Pitney Bowes, the Corporate
logo, MapInfo, Group 1 Software, and
MapInfo Professional are [registered]
trademarks of Pitney Bowes Inc. or a
subsidiary. All other trademarks are the
property of their respective owners.

September 27, 2013

http://www.pitneybowes.com.au/software
http://www.pb.com/software
http://www.pitneybowes.co.uk/software
http://www.pitneybowes.co.in/software
http://www.pb.com/software


If both of these products are installed, then the installer upgrades them at the same time. You do not
need to run this installer multiple times.

To upgrade MapInfo Professional to version 12.0.2 Maintenance Release:
1. From the MapInfo Professional Main menu, select Help > Check for Update. The Maintenance

Releases for MapInfo Professional web page displays.
2. On the web page, click the download link and follow your web browser's instructions for opening and

running the patch file.

The file is called MapInfoProfessional12.0.2MaintenanceRelease.exe should you choose
to save and run it later.

3. Follow the instructions to complete the upgrade.

It is important to wait until the installation completes.

Advanced Installation for System Administrators
This section is for the system administrator installing this Maintenance Release using a command line,
and the network system administrator installing this Maintenance Release across the network using a
Microsoft Patch (MSP) file.

Upgrading in Silent Mode
To run the MapInfo Professional Maintenance Release installer in silent mode, from a command prompt
change directories (cd command) to where the Maintenance Release .exe file is, and then type:
MapInfoProfessional12.0.2MaintenanceRelease.exe /s /v"SILINST=True"

Where:

• /s = runs the setup.exe silently
• /v = passes the parameter "SILINST=True" into the setup.exe to suppress the GUI.

A progress dialog box may display during the installation.

You may see a prompt for permission to continue. Click Allow or OK to proceed.

Upgrading Using a MSP File
Upgrading using a MSP file is not available for version 12.0.2. If you require this type of upgrade, please
contact your Technical Support representative.
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Support Notices

SQL Server 2008 on Vista

Vista is not a supported operating system with MapInfo Professional 12.0. If you choose to install to
VISTA, then be aware that SQL Server 2008 (SQL Server Spatial) provides a different ODBC driver for
Windows Vista.

A Windows Vista user must use the x64 and Itanium versions of sqlncli.msi, which installs the 64-bit and
32-bit versions of SQL Server Native Client, on your 64-bit Windows operating system.

To download the appropriate sqlncli.msi, see http://msdn.microsoft.com/en-us/library/ms131321.aspx.

SQL Server 2012

If connecting to a SQL 2012 server with Windows 7 or higher, use the SQL Server Native Client 2012
(also known as SQL Server Native Client 11.0). If connecting with Windows XP, this client is not supported
and you will need the SQL Server Native Client 10.0.

Bing Maps Expiration Date

Bing Maps has a limited license period, which is specific to each version of MapInfo Professional. The
Bing Maps and the Add Bing Roads to Map and the Move Map To features cease working after this date:

• MapInfo Professional 11.5 on January 1st 2014
• MapInfo Professional 12.0 on January 1st 2015

Customers with a current maintenance package who would like to continue to use earlier versions of
MapInfo Professional (11.0.x or 11.5.x) are entitled to use Bing services until January 1st 2015. For
details, contact your account representative.

Windows XP Support Expires in 2014

Microsoft has announced their retirement of theWindows XP operating system on April 8, 2014. MapInfo
Professional will continue to be supported on this operating system for all MapInfo Professional 12.0.x
releases, but will no longer support this operating system for the MapInfo Professional 12.5 release in
2014.

Maintenance Release 12.0.2
This section lists an update made since the 12.0.1 release. The 12.0.2 Maintenance Release is cumulative
and includes all updates supplied with the 12.0.1 Maintenance Release.

• Shift+Click Support in Browser
• Support for Cyber Japan Tile Server
• Support for HTML format for GetFeatureInfo for WMS layers
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Shift+Click Support in Browser
You can use Shift+Click in a browser window to select a range of rows.

To select a range:
1. Click the button at the left edge of the browser window and select a row.
2. Hold the Shift key and click a second row in the same browser. All rows within that range will be

selected (the row you clicked including the row you have selected using Shift+Click).

Clicking on a row selects the row, but also clears any previous selection. To add another row
to the already selected row, hold down the Ctrl key and click on the row you want to select.

Tip:

Similarly, holding down the Ctrl key while you perform Shift+Click will add that range of rows
to the selection, instead of clearing the previous selection.

Support for Cyber Japan Tile Server
In MapInfo Professional 12.0.2, there will be additional support for the Cyber Japan tile server.

There will not be any MapBasic support for creating this type of table, although there is support for
reading the TAB/XML files. To support this feature, two new sets of TAB files have been created in the
TileServer subdirectory. These tables primarily contain data in the area of Japan, not in other parts of
the world. They are:

1. CyberJapanStandard.tab - This file contains road-like data for Japan at levels 5-18.
2. CyberJapanAerial.tab - This file contains aerial imagery for Japan at levels 15-17.

There is also an additional CyberJapanReadme.txt file included in this version.

Support for HTML format for GetFeatureInfo for WMS layers
Support for HTML format has been added to WMS layers when using the Info tool. Currently, when using
the Info tool on a WMS layer from a server which supports GetFeatureInfo, MapInfo Professional may
be able to display the data in the Info tool provided that the format returned is supported. While it is still
the default behavior, you can now specify that the preferred format for GetFeatureInfo is HTML, provided
the format is supported by the server.

MapInfo Professional will launch the returned HTML data using the default browser on your system. This
data is formatted by the server in a manner that may be easier to read compared to the data in the Info
tool.

MapBasic Syntax

At present, you must enter a MapBasic command in theMapBasicwindow after theWMS table is created
to specify that HTML is the preferred format when using the Info tool.
Set Table tablename Info Tool Prefer HTML {On | Off}

The table must be of type WMS.Note:

Specify "On" to make the preferred format HTML. Specify "Off" to return the default behavior.
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Changing the table setting to Prefer HTML On does not guarantee that the HTML format will
be used. The WMS server must support this format.

Note:

This command will change the XML associated with the .TAB file for this WMS server. This is a one time
task as long as you continue to use the file.

Known Issues

Working with a Metadata Record
When trying to edit a metadata record, the following error message will appear:

No editor found for output schema http://www.isotc211.org/2005/gmd

You will be unable to edit any metadata record.

Workaround

Create a configuration file, mapinfow.exe.config, in the folder whereMapInfo Professional is installed.
Add the following to the file that you created.

<?xml version="1.0" encoding="utf-8" ?>
<configuration>
<runtime>
<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">

<!-- Do not remove the "dependentAssembly" sections related to miadm.dll,
micm.dll, miinteropmanager.dll and mibase.dll -->

<dependentAssembly>
<assemblyIdentity name="miadm" publicKeyToken="1c8d81d2ee78b75d"

culture="neutral" />
<bindingRedirect oldVersion="9.5.0.0-12.0.0.208" newVersion="12.0.0.208"/>

</dependentAssembly>
<dependentAssembly>
<assemblyIdentity name="micm" publicKeyToken="1c8d81d2ee78b75d"

culture="neutral" />
<bindingRedirect oldVersion="9.5.0.0-12.0.0.208" newVersion="12.0.0.208"/>

</dependentAssembly>
<dependentAssembly>
<assemblyIdentity name="miinteropmanager"

publicKeyToken="1c8d81d2ee78b75d" culture="neutral" />
<bindingRedirect oldVersion="9.5.0.0-12.0.0.208" newVersion="12.0.0.208"/>

</dependentAssembly>
<dependentAssembly>
<assemblyIdentity name="mibase" publicKeyToken="1c8d81d2ee78b75d"

culture="neutral" />
<bindingRedirect oldVersion="9.5.0.0-12.0.0.208" newVersion="12.0.0.208"/>

</dependentAssembly>
</assemblyBinding>
</runtime>
</configuration>
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Restart MapInfo Professional.

The number 208 in the attributes oldVersion="9.5.0.0-12.0.0.208" and
newVersion="12.0.0.208" represent the particular build number of MapInfo Professional

Important:

displayed in the File Version item list for the files miadm.dll, micm.dll,
MiInteropManager.dll, and mibase.dll. For MapInfo Professional 12.0.2, this build
number will remain 208.

Progress and Resolution of Outstanding Issues

MapInfo Professional

Description and ResolutionIssue Number

MapInfo Professional closes unexpectedly when trying to return a distributable
license more than once to an inaccesible License Server Utility.

MIPRO-25509

Resolution: Fixed.

In MapInfo Professional, someGeotiff images are unable to geo-register correctly.MIPRO-26270

Resolution: Fixed.

When trying to borrow licenses in different instances of MapInfo Professional,
running simultaneously on a machine, the machine consumes multiple copies of
the license.

MIPRO-27223

Resolution: Fixed.

Legend Designer samples for bar and pie themes are incorrectly proportioned
on a Layout Window.

MIPRO-34326

Resolution: Fixed.

MapInfo Professional sets incorrect field length when opening an Oracle table
containing a field with length defined with ‘chars’ semantics from a database with

MIPRO-34788

multibyte character set. The corresponding field length gets multiplied bymaximum
bytes per character.

Resolution: Fixed.

The Workspace Resolver tool uses the ApplicationDirectory$() function to store
temporary files which are not Windows 7 compliant.

MIPRO-34806

Resolution: Fixed. All temporary files are now written into the temporary folder
instead of the application directory.
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Description and ResolutionIssue Number

MapInfo Professional or MapInfo Runtime closes unexpectedly when a browser
window is embedded in a host window.

MIPRO-34877

Resolution: Fixed. This issue occurs only in integrated applications that embed
a browser window. Dismiss the dialog box, change the selection, and recreate
the dialog box with a new embedded browser window. MapInfo Professional or
MapInfo Runtime would eventually close unexpectedly if the above mentioned
steps are repeated multiple times.

MapInfo Professional generates an error when using the Legend Designer to
add a Legend Text Frame if the text includes a straight double quotation mark (
" ) instead of a smart double quotation mark ( “ and ” ).

MIPRO-35300

Resolution: Fixed. The workaround that was previously described in theMapInfo
Professional 12.0 Release Notes is no longer required.

A table saved as a new SQLite database in a British National Grid (BNG)
projection does not line up with the original WGS 84 table.

MIPRO-35337

Resolution: Fixed. Spatial Reference metadata is now added to all FDO (SQLite)
tables during a File > Save Copy As operation.

When the Autoload option is selected for Google Earth Connection Utility, an
error message appears every timeMapInfo Professional starts. The error message

MIPRO-35430

only appears in situations where the path of the temporary folder contains a "."
(dot), for example, C:\users\user.name\appdata\local\temp\, and write
access is only available on the last folder in the path.

Resolution: Fixed.

The Remove All Guidelines option in the main menu (Legend Designer >
Remove All Guidelines) is enabled or disabled incorrectly.

MIPRO-35557

Resolution: Fixed.

If Spatial Reference tags are used in a TAB file metadata, MapInfo Professional
will try to use themwhen opening the TAB file associated with an SQLite database.

MIPRO-35835

Resolution: Fixed. This Spatial Reference metadata is now updated during a
File > Save Copy As operation for all table types.

The Custom Polyline tool draws an incorrect rubber line when snapping and using
bounded data

MIPRO-36412

Resolution: Fixed. The custom polyline tools are now specified by creating a
toolbar button with DrawMode set to either "DM_CUSTOM_POLYLINE" or
"DM_CUSTOM_POLYGON".
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Description and ResolutionIssue Number

MapInfo Professional closes unexpectedly when panning amap while theHotLink
tool is active.

MIPRO-36904

Resolution: Fixed.

MapInfo Professional or MapInfo Runtime may close unexpectedly due to an
issue in the licensing module.

MIPRO-37464

Resolution: Fixed.

If there are two open database connections, the Open Multiple Table dialog box
lists tables from one database, but does not list the tables from the other database,
after the second database is selected.

MIPRO-37532

Resolution: Fixed.

Whenmultiple layers are selected from the Layer Controlwindow and the Layer
Properties dialog box is opened, clicking the OK button on the Expression
dialog box under the Label Display tab will produce the following error message:

MIPRO-37585

Unhandled exception has occurred in a component in your
application. If you click Continue, the application will
ignore this error and attempt to continue.

Resolution: Fixed. If multiple layers are selected, the Layer Properties dialog
box would not allow you to modify the label expression (unless all selected layers
are based on the same table). The Expression button is disabled when
appropriate.

MapBasic

Description and ResolutionIssue Number

Create Ranges into Variable gives MapBasic error at runtime.MIPRO-32867

The Create Ranges statement calculates thematic ranges, and you can create
ranged Thematic map with numeric or temporal data (date, time, date/time).
However, if the expression in the Create Ranges statement is temporal rather
than numeric, an error occurs when running the application.

Resolution: Fixed. Temporal expressions are now allowed. The variable into
which the ranges are calculated must still be an array of type Float even if the
expression is temporal.

LocateFile$() returns an empty string under certain circumstances for the following
file IDs:

MIPRO-34025
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Description and ResolutionIssue Number

• LOCATE_WMS_SERVERLIST (11): XML list of WMS servers
(MIWMSSERVERS.XML).

• LOCATE_WFS_SERVERLIST (12): XML list of WFS servers
(MIWFSSERVERS.XML).

• LOCATE_GEOCODE_SERVERLIST (13): XML list of geocode servers
(MIGEOCODESERVERS.XML).

• LOCATE_ROUTING_SERVERLIST (14): XML list of routing servers
(MIROUTINGSERVERS.XML).

If you do not use one of the above web services, then the LocateFile$ function
returns an empty string rather than the location of the server list file for that web
service.

Resolution: Fixed. The LocateFile$ function now works correctly for these IDs.
However, geocode and routing server list files are not installed with MapInfo
Professional, so if you have not set up servers for these services, then
LocateFile$() still returns an empty string indicating that the file does not exist.

Maintenance Release 12.0.1
This section lists updates made since the 12.0 release. This update is only for the English release of
MapInfo Professional. This fix has already been applied to non-English releases.

Progress and Resolution of Outstanding Issues

Description and ResolutionIssue Number

When running MapInfo Professional on Windows 8, you may see a display issue
when moving the Map window, sizing it, or restoring it from a maximized state.

MIPRO-35567

The Map window may leave pieces of itself drawn on other windows, usually a
docked window.

Resolution: Fixed.
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